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Introduction to SimApis

1 Introduction to SimApis
A SimApi is a software interface between the Umetrics Suite software and a data source. The primary
purpose of a SimApi is to provide data to SIMCA®-online or SIMCA®.
Sartorius Stedim Data Analytics AB develops SimApis for many different data sources, such as process historians and
general-purpose databases.
This document shows what a SimApi is, and how it is used in Umetrics Suite products. You’ll learn important
technical aspects on SimApis and how to install and troubleshoot. The final chapter is about technical details of
SimApis aimed at developers.

1.1

A SimApi provides data for tags to
Umetrics Suite products

A SimApi exposes a hierarchy of nodes, corresponding to folders
in a file system. Each node can contain other nodes, or tags. A
tag corresponds to a variable. For these tags Umetrics Suite products can obtain data.
The picture shows a tag, Temp, selected in the node BakersYeastControlGood in a data source in SIMCA-online.

1.2

SimApi usage in the Umetrics Suite

SIMCA can use a SimApi to retrieve data for project creation and model building as the following picture illustrates.

Figure 1. SIMCA used to obtain data from a data source through a SimApi.
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SIMCA-online uses SimApis to obtain data in real-time for monitoring and control, as well as write back of data to
the data source. The following picture shows where the SimApi is in a system consisting of a data source, SIMCA-

Figure 2. A SIMCA-online installation with a server with SimApis connecting to data sources, and SIMCA-online clients working with data
on the SIMCA-online server.

online server, and clients.

1.3

Commonly used SimApis

The most widely used SimApis are:
•
•
•
•

The OSIsoft PI SimApis:
the newer PI AF SimApi developed by Sartorius Stedim Data Analytics
the old PI Batch SimApi developed by OSIsoft
The ODBC SimApi - for general access to databases such as SQL Server or Oracle

We recommend that customers use one of these tried and tested SimApis that provides full functionality with
SIMCA-online or SIMCA.
The available SimApis are listed together with their features in paragraph 3.

1.4

The DBMaker SimApi for simulation data

DBMaker is an application provided with the SIMCA-online server installation. It simulates a data source, such as a
process historian, by using a preloaded data table with several observations which are provided one by one to
SIMCA-online through the DBMaker SimApi.
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DBMaker is only used for demonstration purposes and cannot be used in production with live data from a data
source1.
See the built-in help you learn more about DBMaker.

1.5

Additional documentation

The document you are reading now is one of a set of related documents, each with different focus and target
audience. Refer to the below table to learn more.
Source

What

Where

Web site

Introductory information, as well as downloads of
most other documentation below

sartorius.com/umetrics

SIMCA-online
ReadMe and
Installation.pdf

Installation of SIMCA-online and how to quickly get
started with demo data.

In the installation zip file and on
umetrics.com/downloads/simcaonline

SIMCA-online
Implementation
Guide

Outlines SIMCA-online functionality, puts it in
context with other Umetrics Suite software,
describes requirements and best practices for
successful deployment, and step-by-step
installation instructions.

umetrics.com/downloads/simcaonline

SimApi Guide

Preparing for and performing SimApi installations,
including troubleshooting. Also contains technical
details on SimApis for developers.

umetrics.com/simapi

SimApi User Guides

One for each published SimApi. Lists the features,
installation instructions, and configuration specifics
of each individual SimApi.

umetrics.com/simapi

SIMCA-online
Technical Guide

Technical reference for SIMCA-online server
installation planning, troubleshooting, and in-depth
how SIMCA-online works.

umetrics.com/downloads/simcaonline

SIMCA-online help

How to use SIMCA-online and how SIMCA-online
works.

In the software itself, and on
umetrics.com/downloads/simcaonline

SIMCA-online Web
Client Installation
Guide

Describes the installation of the SIMCA-online Web
Client.

umetrics.com/downloads/simcaonline

Umetrics
knowledge base

Searchable database with articles about each
released software version, technical articles, and
known issues on Umetrics Suite products.

umetrics.com/kb

SIMCA help

How to use SIMCA for creating projects.

In SIMCA and on
umetrics.com/downloads/simca

You can publish your own data with DBMaker for testing SIMCA-online or demoing it with your own data. See the
following knowledgebase article for more information: umetrics.com/kb/testing-simca-online-real-world-datawithout-simapi
1
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1.6

Technical support

Sartorius Stedim Data Analytics AB online support team answers technical questions about SimApis and can also
forward requests for enhancement of SimApis to the appropriate people. Learn more at umetrics.com/support.

2 Obtaining SimApis
Sartorius Stedim Data Analytics AB web site provides documentation for SimApis, and links to SimApis which are
offered from partners, at umetrics.com/simapi.
All SimApis built in-house can be acquired for free in the web shop on that page.
Consult the feature matrix to learn more about SimApi functionality and which SimApi that supports which feature.
For details about a specific SimApi, see its User Guide. The individual SimApi user guide and this document have
complementing information when it comes to SimApi installation planning, instructions and troubleshooting tips.

3 SimApi features
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Not all data sources are alike. A SimApi need not implement all functions in the specification. For these reasons,
different SimApis offer different functionality. The following matrix lists available SimApis and their features.
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The below table explains each feature. Notice that the table has separate columns to show which features are
available in SIMCA-online and SIMCA respectively.
Feature

Purpose

SIMCA-online usage

Current data

Read the most recent value
from the data source.

Real-time normal execution

SIMCA usage

SimApi Guide | Ensure Manufacturing Success

5

SimApi features

6

Feature

Purpose

SIMCA-online usage

SIMCA usage

Historical data

Read historical data from the
data source.

Catch-up and predict of past
data, create projects using
File > New

Database Import
Wizard to import
process data for
model creation.

Discrete data

Read laboratory/IPC data from
the data source. Discrete data
can be used for batch
configurations when data needs
to be re-read during the batch
evolution. Many observations
per batch.

For batch projects with
phases configured for
discrete data retrieval.

Batch data

Read batch conditions and final
quality attributes (or other MES
type data). One observation per
batch.

Batch conditions or local
centering.

Database Import
Wizard to read batch
conditions for batch
level model creation.

Batch node

Specify the start time and the
end time (empty for an active
batch) for a specific batch.
Enumerate all batches that
existed in a time range.

Required for execution of
batch configurations.

Database Import
Wizard to select
batches to import.

Write back continuous
data

Write continuous data, such as
predictions, back to the data
source.

Write back for batch
configurations for the batch
evolution level or for
continuous configurations

Write back discrete

Write discrete data, such as
predictions, back to the data
source.

Write back for batch
configurations at the batch
evolution level for phases
configured for discrete data
retrieval

Write back batch data

Write back batch level data,
such as predictions or final
quality attributes, to the data
source.

Write back for batch
configuration at the batch
level

Node hierarchy

The SimApi supports a
hierarchy of nodes, similarly to a
file system. Each node can
contain tags and other nodes.
The hierarchy makes is easier to
manage a large number of
nodes and tags.

Supported in all places where
tags are used.

Array tag
expansion

An array tag stores multiple
values. The SimApi expands the
array tag to many individual
tags, one for each value in the
array.

Supported where tags are
used for continuous data.
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Feature

Purpose

SIMCA-online usage

Multiple data
sources

The SimApi can connect to
more than a single data source
or supports multiple instances
of itself with individual settings
and log files for each instance.

Connect to several different
data sources of the same
kind. See
umetrics.com/kb/multipleinstances-same-simapisimca-online-server

Connection
resiliency

If the SimApi becomes
disconnected from the data
source, it will try to reestablish
the connection.

The SIMCA-online server
doesn't have to be restarted
to reestablish connections to
the data source.

Developed inhouse

The SimApi is developed,
provided and supported by
Sartorius Stedim Data Analytics
AB.

3.1

SIMCA usage

Only Current data is not recommended

Some SimApis, notably OPC DA, only supports reading current data, and not historical data.
A SimApi that only supports current data cannot be used in SIMCA, because it won’t be able to read historical data
on which to build the models.
For SIMCA-online, we recommend a SimApi that supports historical data, but a SimApi with only current data can
work, but there are issues you must be aware of. Learn more in the SIMCA-online Technical Guide.

4 Preparing for a SimApi installation
This section describes important information for a successful installation of a SimApi.

4.1

32- or 64-bit SimApis

There are 32-bit and 64-bit versions of each SimApi. Which one to use depends on the architecture of the program
you want to use it with. For example, a 64-bit SIMCA-online server requires a 64-bit SimApi DLL but a 32-bit SIMCA
desktop software requires a 32-bit SimApi DLL.

4.2 Location for log file and settings

A SimApi stores its log files in the Program Data folder2 in the following location:
%programdata%\Umetrics\SimApi, where %programdata% maps to the actual folder on your computer. It defaults
to C:\ProgramData.
Each SimApi typically uses its own log file, which similarly to the SIMCA-online server log file will contain more or less
data depending on a log level setting. This file is useful for troubleshooting. The log file is named <simapi>.log where
<simapi> is the SimApi that you are installing, for example PIAFSimApi. Also see the next section for SIMCA-online
SimApi instance names.
This folder also contains the SimApi settings in an XML file named <simapi>.xml.
Most SimApis have graphical user interfaces that change the settings in the xml file, but for some you enter the
changes directly in the XML file with a text editor, such as Notepad. See the user guide for each SimApi for more
information.

This folder is hidden in Windows by default. In order to see it in Windows Explorer you configure File Explorer to
show hidden files. Note that you can navigate to a hidden folder by copying and pasting the folder path to File
Explorer’s address bar.
2
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4.3 File names when named instances are used with SIMCA-online 13.1 or later

With SIMCA-online 13.1 or later, each SimApi instance get its own configuration file and log file in order to support
multiple instances of each SimApi. The names of these files are suffixed by the name of the instance as given on the
SimApi tab in the SIMCA-online Server Options dialog. The following example shows the naming of these files,
where <simapi> needs to be replaced with the SimApi name.
Configuration name given when the instance is added: OmegaServer
Configuration file name: <simapi>OmegaServer.xml
Log file name: <simapi>OmegaServer.log
Note that the generic file <simapi>.log file is still created. This log file contains entries that for technical reasons
cannot be directed to the log file of the instances.
Note that SIMCA does not support multiple instances of the SimApi, and therefore uses the names without instance
name as described above.

4.4 Network planning

You should locate the SIMCA-online server close to the data source in the network. This ensures a fast connection
between SIMCA-online and its data source.
Networking equipment may interfere with the connection between SIMCA-online and the data source; firewalls can
for example drop connections after a period of inactivity resulting in problems in SIMCA-online where the data
source becomes disconnected in a SimApi.

4.5 User accounts and data source permissions

Data sources typically control access to their data. This is usually done with usernames and passwords but IPaddress- or DNS-based restrictions can also be used (for example PI Trusts in OSIsoft PI).
The username and password can be provided to the data source in different ways:
•

•
•
•
•
•

A SimApi is run as the Windows user of the user running SIMCA or the SIMCA-online service account on
the server computer. The SimApi can connect to the data source using this account. This is how the OPC
HDA, and the OSIsoft PI SimAPi work, and ODBC if you don’t provide credentials when configurating it.
For generic ODBC you can use the ODBC Data Sources Administrator application found on Start in
Windows.
Some database providers provide their own drivers and tools for their databases. Oracle databases, for
example, use the Oracle Data Access Components (ODAC).
Some SimApis, such as PI AF and ODBC, have configuration dialogs that store the encrypted credentials in
the SimApi XML configuration file.
OPC uses DCOM as the transport between data source and SimApi. DCOM is configured with the
Component Services tool (DCOMCNFG.EXE) in Windows and uses Windows authentication.
For the OSIsoft PI SimApi (not the newer AF SimApi), the OSIsoft AboutPI-SDK application
(PISDKUtility.exe) is used to set up the connection to the PI server. PI also has various security options
available in the PI System Management Tools on the PI server computer. Read more in the PI AF SimApi
User Guide. This guide is helpful even if you use the older OSIsoft PI SimApi.

4.6 Verifying SimApi connectivity

When you want to install a SimApi on a computer it can be useful to verify the connectivity from that computer to
the data source with another tool. Here are some tips on how to do that:
•

•

8

Matrikon OPC Explorer for DA or HDA (these are separate tools) can be used to test OPC connectivity, and
Matrikon OPC Analyzer can be used to diagnose the OPC connectivity issues. Download these free tools
from https://www.matrikonopc.com/products/opc-desktop-tools/index.aspx
OPC Rescue from the OPC Training Institute’s web site “enables users to easily diagnose communication
and security problems, and repair them instantly with the push of a button. All this can be done without ever
having to learn to configure DCOM“
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•

•
•
•

•

•

ODBC Data Sources in Windows is used to configure and test generic ODBC. Note that there are two
versions of this tool on 64-bit Windows: one for 32-bit applications and one for 64-bit3. Use the Test Data
Source button at the end of the ODBC configuration wizard to verify connectivity to the database. We
recommend that you configure your data sources as System DSNs.
A database specific connection tool from the provider of the database, such as the Oracle Data Access
Components.
PI System Explorer can be used to test connectivity to the PI AF server. It is part of the PI AF Client which is
a pre-requisite for the PI AF SimApi.
AboutPI-SDK application (PISDKUtility.exe) can be used to test connectivity and to view any error
messages that might have been logged when SIMCA-online tries to connect to the PI server. This is only
used for the older OSIsoft SimApi, not PIAF.
PI System Management Tools are used on the PI server computer for troubleshooting from that side. For
example, to look for security issues preventing access from the SIMCA-online server. Learn more on PI
system troubleshooting in this YouTube video.
Excel can be used to obtain data from an ODBC connection and most other systems when a suitable plugin
is installed.

5 Installing a SimApi
Here is how to install a SimApi on a computer:
1.
2.
3.
4.
5.
6.
7.

5.1

Read the User Guide for the SimApi you are installing. It contains specifics for that SimApi that complement
the general instructions you are reading now.
Install and configure any prerequisites mentioned in the SimApi User Guide (for example Oracle Data
Access Components for the ODBC SimApi if you want to connect to an Oracle database).
Run the setup program to install the SimApi. Install the 64-bit (x64) or the 32-bit (x86) version that matches
the software you will run it in.
Configure the SimApi in SIMCA-online or SIMCA as described in the following sections and refer to the
user guide of the SimApi for descriptions of available settings.
Start the SIMCA-online server. Note: when the SimApi is initialized, it will enumerate all tags in the data
source. This can take time, especially if there are many tags, if the data source is slow, or if the network
latency is high.
Test the SimApi. For SIMCA-online, you can use File > Extract as described in 6.2.
If the SimApi fails to work as expected, refer to the SimApi log files to help troubleshooting, and to the
SimApi user guide.

Setting up the SimApi for use in SIMCA

Here’s how to use the SimApi in SIMCA:
1.

Start the database import in one of the following ways:
a. In SIMCA: File > New Regular Project or New Batch Project. If the database import wizard is not
opened automatically, open it from File > New Spreadsheet > From Database.
b. In SIMCA: Import Dataset on the Data tab of an open SIMCA project.

In Windows, use Start search to find both the 32- and 64-bit ODBC Data Sources tools. In 64-bit Windows 7 the
start menu only lists the 64-bit version, but you can start the 32-bit ODBC Data Sources program by launching it
manually from the SysWow64-folder, typically C:\Windows\SysWOW64.
3
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2.

Click Add new data source

3.

Select SimApi as the connection type, click the …-button and locate the <simapi>.dll in the installation
folder, and click Open.
Click Configure and refer to the individual SimApi User Guide how to make the settings.
Click the Test data source connection to verify that you can connect to the database.
Click OK to complete the configuration.
Refer to the SIMCA help for how to import data.

4.
5.
6.
7.

5.2 Setting up the SimApi for use in SIMCA-online

Important: To be able to use a SimApi, a SIMCA-online server license is required. A demo installation of SIMCAonline does not allow SimApis to be used.
Here’s how to set up the SimApi in SIMCA-online:
8.

On the server computer, start the SIMCA-online Server Options utility from Start in Windows. Go to the
SimApi tab and click Add...
9. Give this instance of the SimApi a name. Use a name that distinguishes it from other data sources, such as
the server name and type (for example MyPIServer).
10. Click the …-button to browse to and select the <simapi>.dll located in the installation folder.
11. Click OK to add the new SimApi and answer Yes to the question about launching the SimApi configuration
program to make the settings for the SimApi instance.
12. Refer to the User Guide of the SimApi for information about the available settings for it.
To configure multiple instance of this SimApi, repeat the above steps and use unique names for each instance.
Read more about the different log and configuration files for the instances above.

10
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6 Troubleshooting and testing a SimApi installation
This chapter is about testing and troubleshooting a SimApi installation.

6.1

Using the right SIMCA-online service account

When you are testing access to the external data source, remember that you are logged in as a specific user on the
server computer (typically your own user account in a Windows domain), but that the SIMCA-online server service
account by default is LocalSystem which has different access rights compared to your user account. For this reason,
it is not uncommon that the above listed tests work fine, but that SIMCA-online fails to connect to the data source.
To solve this issue, access must be granted for the account that is used by the SIMCA-online server service. Typically,
you change LocalSystem to a specific domain service account, and grant rights to this account.

6.2 Testing a SimApi from SIMCA-online

Here is how to test the SimApi connection from a SIMCA-online client, once the SIMCA-online server has been
started successfully with the new SimApi loaded.
•

Extract tests the SimApi by obtaining data through it using the different modes of data retrieval: current-,
historical-, batch- and discrete data can be extracted and thus tested. Extract is found on the File tab.

•

Predict for batch configurations uses the batch node to list available batches in a time range. If you don’t
see any batches within a time range, then the problem is related to the batch node that is specified for the
configuration. Predict is found on the Administration tab.

•

Find batches found on the Batch node page of the project configuration wizard can like Predict be used to
search for batches in a batch node.

The server log and the SimApi logs are useful if Extract or predict doesn’t work as you expect. Enable Debug-level
logging in both the server log and the SimApi log to get full details. Learn more in http://umetrics.com/kb/makinguse-simca-online-server-logging-finding-problems

7 Technical details on SimApis
This chapter gives technical details on how a SimApi works. It is mainly aimed at developers that want to understand
SimApis for the purpose of implementing a SimApi for a data source, to connect it to SIMCA-online or SIMCA. Also
refer to earlier parts of this document for an introduction to SimApis and to the high-level descriptions of features.

7.1

The SimApi specification and SimApi development

The SimApi specification, SimApi-v2, contains documentation for all functions in the SimApi that a SimApi DLL
needs to implement as well as guidance for how to develop a SimApi.
We also offer an example SimApi implementation written in .NET that handles the transition from a C interface to
.NET making implementation in .NET relatively easy.
A SimApi can be developed by people with knowledge in C, C++ or .NET and good knowledge of the data source
that the SimApi should connect to.
Contact your sales representative to obtain the SimApi Software Development kit.

7.2 Reading or writing data

A SimApi has the main task of providing data from a data source. This is referred to as reading data.
Most SimApi implementations also support writing data. This means writing back data through the SimApi to the
data source.

7.3 Tags and Nodes

A tag is an identifier of a column or “variable” in a data source.
A node is a container of tags. A node can also contain other nodes, similarly to how a file system has folders in folders.
Like in a file system, the node and tag names can be combined to a full path that uniquely identifies a tag. The tag
paths are used in SIMCA-online or SIMCA when selecting tags to use. A tag path starts with a SimApi instance name

SimApi Guide | Ensure Manufacturing Success
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followed by the node-structure, and ending with the tag name, each item separated with a colon (:). For example
“:ODBCSQLServer:Node:SensorTag1”.

7.3.1 Case sensitivity of tag- and node names
Tag names and node names are case sensitive.

Thus, a tag called “tag1” is not the same as “Tag1” because of the different case of the “T”. We recommend against
using tags or node names that differ only in case.

7.3.2 Continuous process node

If a node contains tags with continuous process data, it can be referred to as a process node. The following two
screenshots show a tabular representation of a process node with data followed by a picture showing how the node
looks when selecting tags in SIMCA-online.

Figure 3. An example of a node with data. The node name is Sorting_missing. The first column contains the time stamps of the
observations. The remaining column headers are tags. Each column contains measurements of the tags. Each row constitutes
one observation.

Figure 4: This is how the same node looks from SIMCA-online. You see the node name to the left, and the tags in that
node listed to the right. The full tag path to the Ethanol tag in this screenshot is :DBMaker:Sorting_missing:Ethanol.

To work well in a SimApi a node must be independent of batches, runs, or time. Having a node that contains data for
a specific batch or time range would not work well in SIMCA-online because the project configuration then can only
read data for that batch and not be used for other batches. Instead, a node should be mapped to one or more
physical units in the process where measurements are performed.

7.3.3 Batch node

A batch node is a node that keeps track of batches; their batch identifiers, start times, and end times. It is a
requirement for batch project execution in SIMCA-online. If you don’t have a batch node in your data source, you
can use the Batch Context Generator in SIMCA-online. See the built-in help.

12
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A batch node can also contain batch data; data for which there is only one observation for the whole batch. Note
that tags with batch data need not be in a node that has the full functionality of a batch node. It is enough that the
SimApi supports reading batch data for the tags. Learn more on batch data in 7.5.
Here is an example of a batch node:

Figure 5. A sample batch node named Sorting_missing-BatchNode. The first column contains batch identifiers, followed by the
start time and end time of the batch. The last five columns are tags with batch data (batch conditions). This example also shows
the different data types which are defined in 7.4: QP1 and QP2 are qualitative (text) tags the remaining tags contain numerical
data. Also notice the missing data highlighted in yellow in some cells.

Note: The above screenshot is taken from DBMaker, bundled with SIMCA-online. To see this yourself in DBMaker,
click the View Data button on the Bakers Yeast database to display two windows, one of which is the batch node,
and the other the process data.

7.4 Data types: numerical data, text data and missing data

For each tag, a SimApi can support three types of data: numerical, text and missing:
•

Numerical data are typically real values of process parameters, for example 6.5. The SimApi interface as
currently defined can can only handle 32-bit floating point values. All other numerical data types in a data
source need to be converted to this.

•

Text/string data are used for batch IDs, phase execution conditions or for qualitative variables. The values
for text tag data are case sensitive. This means that the value “running” is not the same as “RUNNING”.

•

Missing values means there is no value to return, i.e. no data.

What type is returned by a SimApi is up to the SimApi implementation. A SimApi knows about the data in the data
source and should return the data type that fits best.

7.5 Three modes of data retrieval: Continuous, Batch and Discrete

The SimApi specification defines three modes of retrieval for data, i.e. three different ways the SimApi can provide
data from tags in a data source (or in the other direction: write data to tags in a data source).
Continuous data retrieval – this refers to data read continuously, and sequentially, observation per observation as
the batch or process evolves. Data is read for a specific time, or range, at a regular interval between observations.
Batch data retrieval – this refers to a single observation with data for an entire batch (not associated with a specific
maturity or time point). Batch attributes and local centering data are read as batch data in SIMCA-online. Batch are
normally read as batch data too (unless they are configured for discrete data retrieval).
Discrete data retrieval – discrete data can consist of several observations for many maturities. But unlike continuous
data, discrete data is not read sequentially but rather all data at once for a specific phase of a batch. Data need not
be spaced with regular intervals of the maturity variable. All data is re-read each time the data is requested, at the
configured interval.
Note that for any given tag data can be requested in any of the three modes, but typically a SimApi will only support
one of these modes for the tag. Likewise, it is theoretically allowed to mix tags within a node, but typically all tags
within a specific node support the same mode of data retrieval.
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Note: For continuous data retrieval and batch data retrieval (but not for discrete4), the data can be read as current
data or historical data which is the topic of the next section.
Note: Not all SimApis support all modes. See umetrics.com/simapi for details.

7.6 Current and Historical data through a SimApi

Reading current data means asking the data source for values of one or more tags at the time of asking. Notice that
the time of the external data source is not used here. The SimApi reports the latest values from the data source to
the SIMCA-online server.
Reading historical data means asking the data source for values of one or more tags for a specific time range with a
specific interval between observations. Notice that here it is the external data source’s local time that is used to find
the data. Therefore, time synchronization in SIMCA-online between data source and servers are important.
Sometimes there can be differences when data is read as real-time current data or historical data. This can be a
problem in SIMCA-online. Read more on this relating to time differences across the system, and interpolation and
compression in the data source in the SIMCA-online Technical Guide.

7.7

Data can be read for any time T

When SIMCA-online asks for a value of a tag for time T it will receive the value from the data source from time T, or
the latest observation in the data source before time T, or an interpolated value for time T. Thus, the server will always
get a value at each time it asks for, even though and observation for this exact time point might not exist in the data
source.

7.8 Error handling

When a SimApi cannot fulfill a request from the data source it can handle this problem in one of two ways; by
returning missing values (no data) or by signaling a SimApi error:
13. Returning missing values to the caller and signaling success allows the caller to continue as normal (but of
course without any data). This is a recommended practice for partial errors such as when data for could be
obtained for some, but not all, tags in a request.
14. Signaling a SimApi error allows the caller (for example the SIMCA-online server) to see this immediately and
to act. This is a recommended practice for requests that fails completely and cannot return any data at all.
SIMCA-online handles missing values or error codes differently, as is described in the SIMCA-online Technical
Guide.

As you saw above, all discrete data is read each time data is requested, and thus it doesn’t make sense talking about
current or historical data here.
4
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